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S

Preface

The Autodesk® Revit® software is a powerful Building Information Modeling (BIM) 
program that works the way architects think. The program streamlines the design 
process through the use of a central 3D model, where changes made in one view 
update across all views and on the printable sheets. 

The objective of the Autodesk® Revit® 2022: Fundamentals for Architecture guide 
is to enable you to create a full 3D architectural project model, including walls, 
doors, windows, components, floors, ceilings, roofs, and stairs, using the basic 
tools that the majority of architectural users need. This includes how to navigate 
the user interface and use the basic drawing, editing, and viewing tools.The final 
part of the course focuses on creating construction documents.

Topics Covered

• Understanding the purpose of BIM and how it is applied in the Autodesk Revit 
software.

• Navigating the Autodesk Revit workspace and interface.

• Working with the basic sketching and modifying tools.

• Review Revit file worksharing, terminology, and workflow.

• Linking CAD and Revit files as the basis of a project.

• Creating Levels and Grids as datum elements for the model.

• Creating a 3D building model with walls, curtain walls, windows, and doors.

• Adding component features, such as furniture and equipment.

• Adding floors, ceilings, and roofs to the building model.

• Modeling stairs, railings, and ramps.

• Setting up sheets for plotting with text, dimensions, details, tags, and 
schedules.

• Creating details.
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Prerequisites

• Access to the 2022.0 version of the software, to ensure compatibility with this 
guide. Future software updates that are released by Autodesk may include 
changes that are not reflected in this guide. The practices and files included 
with this guide might not be compatible with prior versions (e.g., 2021). 

• An understanding of architectural terminology is an asset.

Note on Software Setup

This guide assumes a standard installation of the software using the default 
preferences during installation. Lectures and practices use the standard software 
templates and default options for the Content Libraries.

Students and Educators Can Access Free Autodesk Software 
and Resources

Autodesk challenges you to get started with free educational licenses for 
professional software and creativity apps used by millions of architects, 
engineers, designers, and hobbyists today. Bring Autodesk software into your 
classroom, studio, or workshop to learn, teach, and explore real-world design 
challenges the way professionals do.

Get started today - register at the Autodesk Education Community and download 
one of the many Autodesk software applications available. 

Visit www.autodesk.com/education/home/

Note: Free products are subject to the terms and conditions of the end-user 
license and services agreement that accompanies the software. The software is 
for personal use for education purposes and is not intended for classroom or lab 
use.
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Lead Contributor: Cherisse Biddulph

Cherisse is an Autodesk Certified Professional for Revit as well as an Autodesk 
Certified Instructor. She brings over 19 years of industry, teaching, and technical 
support experience to her role as a Learning Content Developer with ASCENT. 
With a passion for design and architecture, she received her Associates of 
Applied Science in Drafting and Design and has worked in the industry assisting 
firms with their CAD management and software implementation needs as they 
modernize to a Building Information Modeling (BIM) design environment. 
Although her main passion is the Revit design product, she is also proficient in 
AutoCAD, Autodesk BIM 360, and Autodesk Navisworks. Today, Cherisse 
continues to expand her knowledge in the ever-evolving AEC industry and the 
software used to support it.

Cherisse Biddulph has been the Lead Contributor for Autodesk Revit: 
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S

In This Guide

The following highlights the key features of this guide. 

Feature Description

Practice Files The Practice Files page includes a link to the practice files and 
instructions on how to download and install them. The practice files 
are required to complete the practices in this guide.

Chapters A chapter consists of the following - Learning Objectives, 
Instructional Content, Practices, Chapter Review Questions, and 
Command Summary. 

• Learning Objectives define the skills you can acquire by learning 
the content provided in the chapter.

• Instructional Content, which begins right after Learning 
Objectives, refers to the descriptive and procedural information 
related to various topics. Each main topic introduces a product 
feature, discusses various aspects of that feature, and provides 
step-by-step procedures on how to use that feature. Where 
relevant, examples, figures, helpful hints, and notes are provided.

• Practice for a topic follows the instructional content. Practices 
enable you to use the software to perform a hands-on review of a 
topic. It is required that you download the practice files (using the 
link found on the Practice Files page) prior to starting the first 
practice.

• Chapter Review Questions, located close to the end of a 
chapter, enable you to test your knowledge of the key concepts 
discussed in the chapter. 

• Command Summary concludes a chapter. It contains a list of the 
software commands that are used throughout the chapter and 
provides information on where the command can be found in the 
software.

Appendices Appendices provide additional information to the main course 
content. It could be in the form of instructional content, practices, 
tables, projects, or skills assessment.
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S

Introduction to BIM and 
Autodesk Revit

This guide is divided into three sections: Introduction to BIM and Autodesk Revit, 
Design Development Phase, and Construction Documents Phase. 

The first section provides an overview of using Building Information Modeling 
(BIM) with the Autodesk® Revit® software, working with the software interface, 
how to use the basic drawing and modify tools, and incorporating datum 
elements. 

This section includes the following chapters:

• Chapter 1: Introduction to BIM and Autodesk Revit

• Chapter 2: Basic Sketching and Modify Tools

• Chapter 3: Starting Architectural Projects
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S

C h a p t e r

Introduction to BIM and 
Autodesk Revit 

Building Information Modeling (BIM) and the Autodesk® Revit® software work 
hand in hand to help you create smart, 3D models that are useful at all stages in 
the building process. Understanding the software interface and terminology 
enhances your ability to create and navigate around in the various views of the 
model. 

Learning Objectives in This Chapter

• Describe the concept of Building Information Modeling in conjunction with applying Revit.

• Navigate the graphic user interface, including the ribbon (where most of the tools are found), 
the Properties palette (where you make modifications to element information), and the 
Project Browser (where you can open various views of the model).

• Open existing projects and start new projects using templates.

• Use viewing commands to navigate around the model in 2D and 3D views.
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1.1 BIM and Autodesk Revit
Building Information Modeling (BIM) is an approach to the entire 
building life cycle, including design, construction, and facilities 
management. The BIM process supports the ability to 
coordinate, update, and share design data with team members 
across disciplines.

Revit is a model authoring software. It enables you to create 
complete 3D building models (as shown on the left in Figure 1–1) 
that provide considerable information reported through 
construction documents, and enables you to share these models 
with other programs for more extensive analysis.

Figure 1–1

 Revit is a Parametric Building Modeler software:

• Parametric: A relationship is established between building 
elements: when one element changes, all other related 
elements and/or geometry is modified as well. For example, 
when you place a door in a wall, the door removes part of the 
wall and stays inside that wall if it moves. 

• Building: The software is designed for working with buildings 
and the surrounding landscape, as opposed to gears or 
highways. 

• Modeler: A project is built in a single file based on the 3D 
building model, as shown on the left in Figure 1–1. All views, 
such as plans (as shown on the right in Figure 1–1), 
elevations, sections, details, construction documents, and 
reports are generated based on the model.

• It is important that everyone who is collaborating on a project 
works in the same version and build of the software.
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Workflow
and BIM

BIM has changed the process of how a building is planned, 
budgeted, designed, constructed, and (in some cases) operated 
and maintained. 

In the traditional design process, construction documents are 
created independently, typically including plans, sections, 
elevations, details, and notes. Sometimes, a separate 3D model 
is created in addition to these documents. Changes made in one 
document, such as the addition of a light fixture in a plan, have to 
be coordinated with the rest of the documents and schedules in 
the set, as shown in Figure 1–2. 

Figure 1–2

In BIM, the design process revolves around the model, as shown 
in Figure 1–3. Plans, elevations, and sections are simply 2D 
versions of the 3D model, while schedules are a report of the 
information stored in the model. Changes made in one view 
automatically update in all views and related schedules. Even 
Construction Documents update automatically with callout tags 
in sync with the sheet numbers. This is called bidirectional 
associativity.

By creating complete models and associated views of those 
models, Revit takes much of the tediousness out of producing a 
building design.

Figure 1–3
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Revit Terms When working in Revit, it is important to know the typical terms 
used to describe items. Views and reports display information 
about the elements that form a project. There are three types of 
elements: Model, Datum, and View-specific, as shown in 
Figure 1–4 and described below:

Figure 1–4

Model 
element: 
Host

Model 
element: 
Hosted 

Datum 
element

View-specific 
element

Model 
element: 
Stand-alone 

Elevation View

Views Views enable you to display and manipulate the model. 
For example, you can view and work in floor plans, ceiling 
plans, elevations, sections, schedules, and 3D views. 
You can change a design from any view. All views are 
stored in the project.

Reports Reports, including schedules, gather information from the 
building model element that can be presented in the 
construction documents or used for analysis.

Model 
Elements

Includes all parts of a building such as walls, floors, roofs, 
ceilings, doors, windows, plumbing fixtures, lighting 
fixtures, mechanical equipment, columns, beams, 
furniture, casework, plants and many more. 

• Host elements support other categories of elements, 
such as walls (Host Element).

• Hosted elements must be attached to a host element, 
such as doors must be placed on a (host) wall.

• Standalone elements do not require hosts.

Datum 
Elements

Define the project context such as the levels for the 
floors, grids, and reference planes.

View-specific 
Elements

Only display in the view in which they are placed. The 
view scale controls their size. These include annotation 
elements such as dimensions, text, tags, and symbols as 
well as detail elements such as detail lines, filled regions, 
and 2D detail components. 

am
ple

 pr
ov

ide
d b

y A
SCENT fo

r r
ev

iew
 on

ly 

All c
op

yin
g a

nd
 re

us
e s

tric
tly

 fo
rbi

dd
en

. 
1–4 © 2021, ASCENT - Center for Technical Knowledge®



Introduction to BIM and Autodesk Revit

S

The software includes 
tools for architectural, 
mechanical, electrical, 
plumbing, and structural 
design.

• Revit elements are “smart”: the software recognizes them as 
walls, columns, plants, ducts, or lighting fixtures, etc. This 
means that the information stored in their properties 
automatically updates in schedules, which ensures that views 
and reports are coordinated across an entire project, and are 
generated from a single model.

Revit and
Construction

Documents

In the traditional workflow, the most time-consuming part of the 
project is the construction documents. With BIM, the base views 
of those documents (i.e., plans, elevations, sections, and 
schedules) are produced automatically and update as the model 
is updated, saving hours of work. The views are then placed on 
sheets that form the construction document set.

For example, a floor plan is duplicated. Then, in the new view, all 
but the required categories of elements are hidden or set to 
halftone and annotations are added. The plan is then placed on 
a sheet, as shown in Figure 1–5.

Figure 1–5

• Work can continue on a view and is automatically updated on 
the sheet.

• Annotating views in the preliminary design phase is often not 
required. You might be able to wait until you are further along 
in the project.
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1.2 Overview of the Interface
The Autodesk Revit interface is designed for intuitive and 
efficient access to commands and views. It includes the ribbon, 
Quick Access Toolbar, Navigation Bar, and Status Bar, which are 
common to most of the Autodesk® software. It also includes tools 
that are specific to the Autodesk Revit software, including the 
Properties Palette, Project Browser, and View Control Bar. Revit 
includes access to tools for architectural, mechanical, electrical, 
plumbing, and structural design but can be altered by utilizing the 
Customized Workspace. Setting up a Customized Workspace 
tailors your Revit environment to your specific discipline. A 
breakdown of the Revit interface is shown in Figure 1–6.

Figure 1–6

63 42

7

9

8

10

51

11

1. Home Screen 7. File Tab

2. Quick Access Toolbar 8. Properties Palette

3. View Tabs 9. Project Browser

4. Options Bar 10. View Control Bar

5. Ribbon 11. Status Bar

6. Navigation Bar
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1. The Home Screen

When you first open the Autodesk Revit software, the Home 
screen displays with recently used projects and families, as 
shown in Figure 1–7. 

Figure 1–7

• From the Home Screen, you can select the picture of a 
recently opened project or use one of the options on the left 
to open or start a new project using the default templates.

• In the Quick Access Toolbar, click  (Home) to return to the 
screen. 

• In the Home screen, click  (Back) to return to the active 
model. 

• Press <Ctrl>+<D> to toggle between the Home screen and 
active model.am
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2. Quick Access Toolbar

The Quick Access Toolbar (shown in Figure 1–8) includes 
commonly used commands, such as Home, Open, Save, Undo, 
Redo, and Print. It also includes frequently used annotation 
tools, including Measuring tools, Aligned Dimension, Tag by 
Category, and Text. Viewing tools, including several different 3D 
Views and Sections, are also easily accessed here.

Figure 1–8

The top toolbar also hosts the InfoCenter (as shown in 
Figure 1–10) which includes the Autodesk sign-in, access to the 
Autodesk App Store, and Help options. A search field, as shown 
in Figure 1–11, is also available to find help on the web. 

Figure 1–10

Figure 1–11

Hint: Customizing the Quick Access Toolbar

Right-click on the Quick Access Toolbar to change the docked 
location of the toolbar to be above or below the ribbon, or to 
add, relocate, or remove tools on the toolbar. You can also 
right-click on a tool in the ribbon and select Add to Quick 
Access Toolbar, as shown in Figure 1–9.

 
Figure 1–9

Click here to expand or collapse the search field
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3. View Tabs

Each view of a project opens in its own tab and can be pulled out 
of the application window and moved to another monitor. Each 
view displays a Navigation Bar (for quick access to viewing tools) 
and the View Control Bar, and elevation markers, as shown in 
Figure 1–12. 

• To close a tab, press the X that displays when you hover over 
the tab or the name in the list, as shown in Figure 1–12.

In 3D views you can 
also use the ViewCube 
to orbit the view.

Figure 1–12

• Click on the tab to switch between views. You can also:

• Press <Ctrl>+<Tab>.

• Select the view in the Project Browser.

• In the Quick Access Toolbar or View tab>Windows panel, 

expand  (Switch Windows) and select the view from 
the list.

Navigation Bar

Click to close the view

View tabs

View Control Bar

Elevation 
Marker
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• Expand the drop-down list at the far end of the tabs, as 
shown in Figure 1–13.

Figure 1–13

• To close all open views except the current view, in the Quick 

Access Toolbar or View tab>Windows panel, click  (Close 
Inactive Views). If you have multiple projects open, one view 
of each project remains open. If you have dragged a view to 
another monitor, that view will need to be manually closed by 
clicking the X in the upper right corner.

• You can switch between tabbed and tiled views from the View 

tab>Windows panel by clicking  (Tab Views) or  (Tile 
Views).

• Drag the edge of tiled views to resize them. The other views 
resize to match.

4. Options Bar

The Options Bar displays options that are related to the selected 
command or element. For example, when the Rotate command 
is active it displays options for rotating the selected elements, as 
shown at the top in Figure 1–14. When the Place Dimensions 
command is active it displays dimension related options, as 
shown at the bottom in Figure 1–14.

Figure 1–14

5. Ribbon

The ribbon contains tools in a series of tabs and panels as 
shown in Figure 1–15. Selecting a tab displays a group of related 
panels. The panels contain a variety of tools, grouped by task.

Options Bar for Rotate Command

Options Bar for Dimension Commandam
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Figure 1–15

When you start a command that creates new elements or you 
select an element, the ribbon displays the Modify | contextual 
tab. This contains general editing commands and command 
specific tools, as shown in Figure 1–16.

Figure 1–16

• When you hover over a tool on the ribbon, tooltips display the 
tool’s name and a short description. If you continue hovering 
over the tool, a graphic displays (and sometimes a video), as 
shown in Figure 1–17.

Figure 1–17

• Many commands have shortcut keys. For example, type AL 
for Align or MV for Move. They are listed next to the name of 
the command in the tooltips. Do not press <Enter> when 
typing shortcuts.

Contextual tab
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• To arrange the order in which the ribbon tabs are displayed, 
select the tab, hold <Ctrl>, and drag it to a new location. The 
location is remembered when you restart the software.

• Any panel can be dragged by its title into the view window to 
become a floating panel. Click the Return Panels to Ribbon 
button (as shown in Figure 1–18) to reposition the panel in 
the ribbon.

Figure 1–18

6. Navigation Bar

The Navigation Bar enables you to access the 2D and Full 
Navigation (3D views) Wheel to navigate the view, as well as the 
Zoom in Region viewing commands, as shown in Figure 1–19.

Figure 1–19

Hint: You are always in a command when using Revit.

When you are finished working with a tool, you typically default 
back to the Modify command. To end a command, use one of 
the following methods: 

• In any tab on the ribbon, click  (Modify).

• Press <Esc> once or twice to revert to Modify.

• Right-click and select Cancel... once or twice.

• Start another command.

2D Wheel

Zoom in Region
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7. File Tab

If you click the primary 
icon, rather than the 
arrow, it starts the 
default command.

The File tab of the ribbon provides access to file commands, 
settings, and documents, as shown in Figure 1–20. Hover the 
cursor over a command to display a list of additional tools.

Figure 1–20

• To display a list of recently used documents, click 

(Recent Documents). The documents can be reordered 
as shown in Figure 1–21. 

Click  (Pin) next to a 
document name to keep 
it available.

Figure 1–21
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• To display a list of open documents and views, click 

(Open Documents). The list displays the documents and 
views that are open, as shown in Figure 1–22.

You can use the Open 
Documents list to 
change between views.

Figure 1–22

• Click  (Close) to close the current project.

• At the bottom of the menu, click Options to open the Options 
dialog box or click Exit Revit to exit the software.

8. Properties Palette

The Properties palette contains several parts, as shown in 
Figure 1–23. The Type Selector can be found at the top, which 
enables you to choose the size or style of the element you are 
adding or modifying. The options available on the palette enable 
you to make changes to information (parameters). There are two 
types of properties:

• Instance Properties are set for the individual element(s) you 
are creating or modifying. 

• Type Properties control options for all elements of the same 
type. If you modify these parameter values, all elements of 
the selected type change.

The Properties palette is usually kept open while working on a 
project to easily permit changes at any time. If it does not display, 

in the Modify tab>Properties panel, click (Properties) or 
type PP. Alternatively, you can right click in the view and select 
Properties.
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Some parameters are 
only available when you 
are editing an element. 
They are grayed out 
when unavailable.

Figure 1–23

• Options for the current view display if the Modify command is 
active, but you have not selected an element.

• If a command or element is selected, the options for the 
associated element display.

• You can save the changes by either moving the cursor off of 
the palette, or by pressing <Enter>, or by clicking Apply. 

• When you start a command or select an element, you can set 
the element type in the Type Selector, as shown in 
Figure 1–24.

You can limit what 
shows in the drop-down 
list by typing in the 
search box.

Figure 1–24

Type Selector

Filter drop-down 

Instance 
Properties 

Access to Type 
Properties

Search Box
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• When multiple elements are selected, you can filter the type 
of elements that display using the drop-down list, as shown in 
Figure 1–25.

The Properties palette can be placed on a second monitor, or 
floated, resized, and docked on top of the Project Browser or 
other dockable palettes, as shown in Figure 1–26. Click the tab 
to display its associated palettes.

9. Project Browser

The Project Browser lists all views of the model in which you can 
work (as shown in Figure 1–27) and any additional views that 
you create, such as floor plans, ceiling plans, 3D views, 
elevations, sections, etc. It also includes schedules, legends, 
sheets (for plotting), lists of families by category, groups, and 
Revit links. 

The Project Browser 
displays the name of the 
active project.

Figure 1–27

Figure 1–25 Figure 1–26
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• To display the views associated with a view type (i.e. floor 

plans, ceiling plans, etc.), click (Expand) next to the 
section name. To hide the views in the section, click 

(Collapse). You can also expand and collapse sets using 
the shortcut menu, as shown in Figure 1–28.

Figure 1–28

• To open a view, double-click on the view name or right-click 
and select Open.

• To rename a view, slowly click twice on the view name and 
the text highlights as shown in Figure 1–29. You can also 
right-click on a view name and select Rename... or press 
<F2>.

Figure 1–29

• If you no longer require a view, you can delete it. Right-click 
on its name in the Project Browser and select Delete.

• The Project Browser can be customized by changing the 
Browser Organization or its location within the application. 
The Project Browser can be floated, resized, or docked on 
top of the Properties palette.
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How To: Search the Project Browser

1. In the Project Browser, right-click on the top level view and 
select Search..., as shown in Figure 1–30.

Figure 1–30

2. In the Search in Project Browser dialog box, type the words 
that you want to find (as shown in Figure 1–31), and 
click Next.

3. In the Project Browser, the first instance of that search 
highlights, as shown in Figure 1–32.

4. Continue using Next and Previous to move through the list.
5. Click Close when you are done.

10. View Control Bar

The View Control Bar (shown in Figure 1–33) displays at the 
bottom of each view window. It controls aspects of that view, 
such as the scale and detail level. It also includes tools that 
display parts of the view and hide or isolate elements in the view.

Figure 1–33

• The number of options in the View Control Bar change when 
you are in a 3D view, as shown in Figure 1–34.

Figure 1–34

Figure 1–31 Figure 1–32
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Tool Tooltip Description

View Scale Set the scale of individual views.

Detail Level Set the detail level of a view.

Visual Style Various graphic style representations.

Sun Path On/Off Control the visibility of the sun’s path.

Shadows On/Off Control elements’ shadow visibility in a 
view.

Show/Hide 
Rendering Dialog

Available in 3D only. Shows or hides the 
rendering dialog box.

Crop View Define the crop boundaries for a view.

Show/Hide Crop 
Region

Display the crop region in a view.

Unlocked/Locked 
3D Views

Lock a 3D view’s orientation.

Temporary 
Hide/Isolate

Temporarily isolate/hide by category or 
element.(View specific)

Reveal Hidden 
Elements

View hidden elements or unhide them in 
the active view.

Worksharing 
Display 

Available when worksharing is enabled. 
Control display settings.

Temporary View 
Properties 

Enable, apply or restore view properties 
and display recent templates and apply 
them.

Show or Hide the 
Analytical Model

Only used for Structural and MEP to 
display the analytical information.

Highlight 
Displacement Sets

Also known as exploded views.

Reveal 
Constraints

Temporarily view the dimension and 
alignment constraints in the active view.

Preview Visibility Available in the Family Editor only. Control 
the visibility of the preview.
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11. Status Bar

The Status Bar provides information about the current process, 
such as the next step for a command, as shown in Figure 1–35.

Figure 1–35

Other options in the Status Bar are related to Worksets and 
Design Options (advanced tools) as well as selection methods 
and filters.

Hint: Shortcut Menus

Shortcut menus help you to work smoothly and efficiently by 
enabling you to quickly access required commands. These 
menus provide access to basic viewing commands, recently 
used commands, and the available Browsers, as shown in 
Figure 1–36. Additional options vary depending on the element 
or command that you are using.

Figure 1–36am
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1.3 Starting Projects
File operations to open existing files, create new files from a 
template, and save files in Revit are found in the File tab, as 
shown in Figure 1–37. 

Figure 1–37

There are three main file formats: 

• Project files (.rvt): These are where you do the majority of 
your work in the building model by adding elements, creating 
views, annotating views, and setting up printable sheets. 
They are initially based on template files.

• Family files (.rfa): These are separate components that can 
be inserted in a project. They include elements that can stand 
alone (e.g., a table or piece of mechanical equipment) or are 
items that are hosted in other elements (e.g., a door in a wall 
or a lighting fixture in a ceiling). Title block and Annotation 
Symbol files are special types of family files.

• Template files (.rte and .rft): These are the base files for 
any new project or family. Project templates (.rte) hold 
standard information and settings for creating new project 
files. The software includes several templates for various 
types of projects. You can also create custom templates. 
Family templates (.rft) include base information for creating 
families. Template files are usually saved as a new file.
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Opening
Projects

To open an existing project, in the Quick Access Toolbar or File 

tab, click  (Open), or press <Ctrl>+<O>. The Open dialog box 
opens, and you can navigate to the required folder and select a 
project file. An example of the Open dialog box is shown in 
Figure 1–38.

Figure 1–38

• The software release version of the currently selected project 
displays below the preview. Do not open a drawing that 
should remain in an earlier version, as you cannot save back 
to previous versions.

Note: It is important that everyone working on a project uses 
the same software version (e.g., 2021) and is on the same 
updated version (e.g., 2021.1). While your software may be 
able to open files created in its earlier versions, it will not 
be able to open files created in versions newer than the one 
you are using currently. For example, if you are working in 
Revit 2021, you cannot open a model created in Revit 2022.am
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• When you open a file created in an earlier version, the Model 
Upgrade dialog box (shown in Figure 1–39) indicates the 
release of a file and the release to which it will be upgraded. If 
needed, you can cancel the upgrade before it completes.

Figure 1–39

Hint: Opening Workset-Related Files

Worksets are used when the project becomes large enough for 
multiple people to work on it at the same time. At this point, a 
central file with multiple worksets (such as element interiors, 
building shell, and site) that are used by the project team 
members is created.

When you open a workset-related file it creates a new local file 
on your computer as shown in Figure 1–40. Do not work in the 
main central file.

Figure 1–40

• For more information about opening and saving 
workset-related files, see Appendix B Introduction to 
Worksets.

• When you click on a central model showing in the Home 
screen, a local copy of the file is created.

• For more information on establishing and using Worksets, 
refer to the ASCENT guide Autodesk Revit: Collaboration 
Tools.
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Starting
New Projects

New projects are based on a template file. The template file 
includes preset levels, views, and some families, such as wall 
styles and text styles. Check with your BIM Manager about which 
template you need to use for your projects. Your company might 
have more than one based on the types of building that you are 
designing.

How To: Start a New Project

1. In the File tab, expand  (New) and click (Project) (as 
shown in Figure 1–41), or press <Ctrl>+<N>.

Figure 1–41

2. In the New Project dialog box (shown in Figure 1–42), select 
the template that you want to use and click OK.

The list of Template files 
is set in the Options 
dialog box in the File 
Locations tab. It might 
vary depending on the 
installed product and 
company standards.

Figure 1–42am
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You can select from a 
list of templates if they 
have been set up by 
your BIM Manager.

• You can add  (New) to the Quick Access Toolbar. At the 

end of the Quick Access Toolbar, click  (Customize Quick 
Access Toolbar) and select New, as shown in Figure 1–43.

Figure 1–43

Saving Projects It is important to save your projects frequently. In the Quick 

Access Toolbar or File tab click  (Save), or press <Ctrl>+<S> 
to save your project. If the project has not yet been saved, the 
Save As dialog box opens, where you can specify a file location 
and name.

• To save an existing project with a new name, in the File tab, 

expand  (Save As) and click (Project). 

• If you have not saved in a certain amount of time, the 
software will notify you with the Project Not Saved Recently 
alert box, as shown in Figure 1–44. Select Save the project. 
If you want to set reminder intervals or not save at this time, 
select one of the other two options shown in Figure 1–44.

Figure 1–44
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• You can set the Save Reminder interval to 15 or 30 minutes, 
1, 2, or 4 hours, or to have No reminders display. In the File 
tab, click Options to open the Options dialog box. Select 
General and set the interval as shown in Figure 1–45.

Figure 1–45

Saving Backup Copies

By default, the software saves a backup copy of a project file 
when you save the project. Backup copies are numbered 
incrementally (e.g., My Project.0001.rvt, My Project.0002.rvt, 
etc.) and are saved in the same folder as the original file. In the 
Save As dialog box, click Options... to control how many backup 
copies are saved. The default number is three backups. If you 
exceed this number, the software deletes the oldest backup file.
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Hint: Saving Workset-Related Projects

If you use worksets in your project, you need to save the project 
locally and to the central file. It is recommended to save the 
local file frequently, just like any other file, and save to the 
central file every hour or so by synchronizing with the central 
file. 

To synchronize your changes with the main file, in the Quick 

Access Toolbar expand  (Synchronize and Modify Settings) 

and click (Synchronize Now). After you save to the central 
file, save the file locally again.

At the end of the day, or when you are finished with the current 

session, in the Quick Access Toolbar, expand (Synchronize 

and Modify Settings) and click  (Synchronize and Modify 
Settings) to relinquish the files you have been working on to the 
central file.

• The maximum number of backups for workset-enabled files 
is set to 20 by default.

• Note: Workshared files do not have the same backup files 
as non-workshared files.
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1.4 Viewing Commands
Viewing commands are crucial to working efficiently in most 
drawing and modeling programs and Revit is no exception. Once 
in a view, you can use the Zoom controls to navigate in it. You 
can zoom in and out and pan in any view. There are also special 
tools for viewing in 3D.

Zooming and
Panning

Using the Mouse to Zoom and Pan

Use the mouse wheel (shown in Figure 1–46) as the main 
method of moving around the models.

Figure 1–46

• Scroll the wheel on the mouse up to zoom in and down to 
zoom out.

• Hold the wheel and move the mouse to pan.

• Double-click on the wheel to zoom to the extents of the 
view.

• In a 3D view, hold <Shift> and the mouse wheel and move 
the mouse to orbit around the model.

• When you save a model and exit the software, the pan and 
zoom location of each view is remembered. This is especially 
important for complex models.

Mouse 
Wheel
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Zoom Controls

A number of additional zoom methods enable you to control the 
screen display. Zoom and Pan can be performed at any time 
while using other commands.

• You can access the Zoom commands in the Navigation Bar 
in the upper right corner of the view (as shown in 
Figure 1–47). You can also access them from most shortcut 
menus and by typing the shortcut commands.

 (2D Wheel) 
provides cursor-specific 
access to Zoom and 
Pan.

Figure 1–47

Zoom Commands

Zoom In Region 
(ZR)

Zooms into a region that you define. Drag the 
cursor or select two points to define the 
rectangular area you want to zoom into. This is 
the default command.

Zoom Out(2x) 
(ZO)

Zooms out to half the current magnification 
around the center of the elements.

Zoom To Fit 
(ZF or ZE)

Zooms out so that the entire contents of the 
project only display on the screen in the current 
view.

Zoom All To Fit 
(ZA)

Zooms out so that the entire contents of the 
project display on the screen in all open views.

Zoom Sheet 
Size (ZS)

Zooms in or out in relation to the sheet size.

N/A Previous 
Pan/Zoom (ZP)

Steps back one Zoom command.

N/A Next Pan/Zoom Steps forward one Zoom command if you have 
done a Previous Pan/Zoom.
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Viewing in 3D Even if you started a project entirely in plan views, you can 
quickly create 3D views of the model, as shown in Figure 1–48. 
There are two types of 3D views: isometric views created by the 
Default 3D View command and perspective views created by 
the Camera command.

Figure 1–48

Working in 3D views helps you visualize the project and position 
some of the elements correctly. You can create and modify 
elements in both isometric and perspective 3D views, just as you 
can in plan views. 

• Once you have created a 3D view, you can save it and easily 
return to it. 

How To: Create and Save a 3D Isometric View

1. In the Quick Access Toolbar or View tab>Create panel, click 

 (Default 3D View). The default 3D Southeast isometric 
view opens, as shown in Figure 1–49. 

You can spin the view to 
a different angle using 
the mouse wheel or the 
middle button of a 
three-button mouse. 
Hold <Shift> as you 
press the wheel or 
middle button and drag 
the cursor.

Figure 1–49

2. Modify the view to display the building from other directions. 
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3. In the Project Browser, double-click slowly or right-click on 
the {3D} view and select Rename....

4. The name is placed in a text box with the original name 
highlighted, as shown in Figure 1–50. Type a new name in 
the Rename View dialog box, as shown in Figure 1–51.

All types of views can 
be renamed.

• When changes to the default 3D view are saved and you start 
another default 3D view, it displays the Southeast isometric 
view once again. If you modified the default 3D view but did 
not save it to a new name, the Default 3D View command 
opens the view in the last orientation you specified.

How To: Create a Perspective View

1. Switch to a Floor Plan view.
2. In the Quick Access Toolbar or View tab>Create panel, 

expand  (Default 3D View) and click  (Camera).
3. Place the camera on the view.
4. Point the camera in the direction in which you want it to shoot 

by placing the target on the view, as shown in Figure 1–52.

Figure 1–52

Figure 1–50 Figure 1–51

Target

Camera
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A new view is displayed, as shown in Figure 1–53.

Use the round controls 
to modify the display 
size of the view and 
press <Shift> + the 
mouse wheel to change 
the view.

Figure 1–53

5. In the Properties palette, scroll down and adjust the Eye 
Elevation and Target Elevation as needed. 

• If the view becomes distorted, reset the target so that it is 
centered in the boundary of the view (called the crop region). 

In the Modify | Cameras tab>Camera panel, click  (Reset 
Target).

• You can further modify a view by adding shadows, as shown 

in Figure 1–54. In the View Control Bar, toggle  (Shadows 

Off) and  (Shadows On). Shadows display in any model 
view, not just in the 3D views. To set up the sun location, 

expand  (Sun Path Off) and select Sun Settings... Select 

 (Sun Path On) to see the visual location of the sun.

Figure 1–54
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Hint: Using the ViewCube

The ViewCube provides visual clues as to where you are in a 
3D view. It helps you move around the model with quick access 
to specific views (such as top, front, and right), as well as 
corner and directional views, as shown in Figure 1–55.

Figure 1–55

Move the cursor over any face of the ViewCube to highlight it. 
Once a face is highlighted, you can select it to reorient the 
model. You can also click and drag on the ViewCube to orbit 
the box, which rotates the model.

•  (Home) displays when you roll the cursor over the 
ViewCube. Click it to return to the view defined as Home. To 
change the Home view, set the view as you want it, 
right-click on the ViewCube, and select Set Current View 
as Home.

• The ViewCube is available in isometric and perspective 
views.

• You can switch between Perspective and Isometric mode by 
right-clicking on the View Cube and selecting Perspective 
or Orthographic. 

 ViewCube
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Visual Styles Any view can have a visual style applied. The Visual Style 
options found in the View Control Bar (as shown in Figure 1–56), 
specify the shading of the building model. These options apply to 
plan, elevation, section, and 3D views.

Figure 1–56

•  (Wireframe) displays the lines and edges that make up 
elements, but hides the surfaces. This can be useful when 
you are dealing with complex intersections.

•  (Hidden Line) displays the lines, edges, and surfaces of 
the elements, but it does not display any colors. This is the 
most common visual style to use while working on a design.

•  (Shaded) and  (Consistent Colors) give you a sense of 
the materials, including transparent glass. An example that 
uses Consistent Colors is shown in Figure 1–57.

Figure 1–57
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•  (Realistic) displays what is shown when you render the 
view, including RPC (Rich Photorealistic Content) 
components and artificial lights. It takes a lot of computer 
power to execute this visual style. Therefore, it is better to 
use the other visual styles most of the time as you are 
working.

Hint: Rendering

Rendering is a powerful tool which enables you to display a 
photorealistic view of the model you are working on, such as 
the example shown in Figure 1–58. This can be used to help 
clients and designers understand a building’s design in better 
detail. 

Figure 1–58

• In the View Control Bar, click  (Show Rendering Dialog) 
to set up the options. Show Rendering Dialog is only 
available in 3D views.
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Practice 1a Open and Review a Project

In this practice, you will open a project file and view each of the 
various areas in the interface. You will investigate elements, 
commands, and their options. You will also open views through 
the Project Browser and view the model in 3D, as shown in 
Figure 1–59.

Figure 1–59

• This is a version of the main project you will work on 
throughout this guide. 

Practice Objectives

• Navigate the graphic user interface.

• Manipulate 2D and 3D views by zooming and panning.

• Create 3D Isometric and Perspective views.

• Set the Visual Style of a view.
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Task 1 - Explore the interface.

1. In the File tab, expand  (Open) and click (Project).

• If you are on the Home screen, in the MODELS section, 
click Open....

2. In the Open dialog box, navigate to the practice files folder 
and select Modern-Hotel-Final-M.rvt.

3. Click Open. The 3D view of the modern hotel building opens 
in the view window.

If the Project Browser 
and Properties palette 
are docked over each 
other, use the Project 
Browser tab at the 
bottom to display it.

4. In the Project Browser, expand the Floor Plans node. 
Double-click on Floor 1 to open it. This view is referred to as 
Floor Plans: Floor 1.

5. Take time to review the floor plan to get acquainted with it.

6. Review the various parts of the screen.

7. In the view, hover the cursor over one of the doors. A tooltip 
displays describing the element, as shown in Figure 1–60.

Figure 1–60

8. Hover the cursor over another element to display its 
description.

9. Select a door. The ribbon changes to the Modify | Doors tab.

10.Click in an empty space in the view to release the selection.

11. Hold <Ctrl> and select several elements of different types. 
The ribbon changes to the Modify | Multi-Select tab.

12.Press <Esc> to clear the selection.
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13. In the Architecture tab>Build panel, click  (Wall) or type 
the shortcut WA. The ribbon changes to the Modify | Place 
Wall tab and at the end of the ribbon, the Draw panel is 
displayed. It contains tools that enable you to create walls. 
The rest of the ribbon displays the same tools that are found 
on the Modify tab.

14. In the Select panel, click  (Modify) to return to the main 
ribbon.

15. In the Architecture tab>Build panel, click  (Door) or type 
the shortcut DR. The ribbon changes to the Modify | Place 
Door tab and displays the options and tools you can use to 
create doors.

16. In the Select panel, click  (Modify) to return to the main 
ribbon.

17.Save the project.

Task 2 - Look at views.

You might need to 
widen the Project 
Browser to display the 
full names of the views.

1. In the Project Browser, verify that the Floor Plans node is 
open. Double-click on the Floor 1 - Furniture Plan view.

2. This floor plan displays with the furniture, but without the 
annotations that were displayed in the Floor 1 view. 

3. Open the Floor 1 - Life Safety Plan view by double-clicking 
on it.

4. The walls and furniture display, but the furniture is grayed out 
and red lines describing important life safety information 
display.

5. At the top of the views, click each tab to switch between the 
open views. 

6. In the View tab>Windows panel, click  (Tile Views) or type 
WT. All of the open views are tiled. Type ZA (for Zoom All) to 
zoom out to the extents of each view, as shown in 
Figure 1–61.
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Figure 1–61

7. Click inside the 3D view to make it active.

8. In the View tab>Windows panel, click  (Tab Views) or type 
TW. The views return to the tabs and the 3D view is first in 
the group.

This view is referred to 
as Elevations 
(Building Elevation): 
East view.

9. In the Project Browser, scroll down and expand Elevations 
(Building Elevation). Double-click on the East elevation to 
open the view.

10.Expand Sections (Building Section) and double-click on the 
E/W Building Section to open it.

11. At the bottom of the view window, in the View Control Bar, 

click  (Visual Style) and select Shaded. The elements in 
the view are now easier to read.

12. In the Project Browser, scroll down to the Sheets (all) node 
and expand the node.
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13.View several of the sheets. Some have views already 
applied, (e.g., A1.5: Floor 2 - Floor Plan View, as shown in 
Figure 1–62).

Figure 1–62

14.Save the project.

Task 3 - Practice viewing tools.

1. At the far right of the view tabs, expand Switch Windows and 
select Floor 1, as shown in Figure 1–63.

Figure 1–63
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2. In the Navigation Bar, click  and select Zoom In Region 
or type ZR. Zoom in on the stairs.

3. Pan to another part of the building by holding and dragging 
the middle mouse button or wheel. Alternatively, you can use 
the 2D Wheel in the Navigation Bar.

4. Double-click on the mouse wheel to zoom out to fit the 
extents of the view.

5. In the Quick Access Toolbar, click  (Default 3D View) to 
open the default 3D view, as shown in Figure 1–64.

Figure 1–64

6. Hold <Shift> and use the middle mouse button or wheel to 
orbit the model in the 3D view.

7. In the View Control Bar, change the Visual Style to 

(Shaded). Then try  (Consistent Colors). Which one 
works best when you view the back of the building?

The ViewCube is 
located in the upper 
right corner of the view.

8. Use the ViewCube to find a view that you want to use.

9. In the Project Browser, expand 3D Views and right-click on 
the {3D} view and select Rename.... and type in a new name 
for the view as 3D Model. Alternatively, you can slowly 
double click on the view name to rename the view.
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10.Review the other 3D views that have already been created.

11. Press <Ctrl>+<Tab> to cycle through the open views. 

12. In the Quick Access Toolbar, expand  (Switch Windows) 
and select the Modern-Hotel-Final-M.rvt - Floor Plan: 
Floor 1 view.

13. In the Quick Access Toolbar, click  (Close Inactive Views). 
This closes all of the other windows except the one in which 
you are working.

14. In the Quick Access Toolbar, expand  (Default 3D View) 

and click  (Camera), as shown in Figure 1–65.

Figure 1–65

15.Click the first point near the Lobby room name and click the 
second point (target) outside the building, as shown in 
Figure 1–66.

Figure 1–66

16.The furniture and planters display even though they did not 
display in the floor plan view. 

17. In the View Control Bar, set the Visual Style to  (Realistic).

Click to expand

1st point 2nd point
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18. In the Project Browser, right-click on the new camera view 
and select Rename.... Type CAM Lobby Seating Area.

19. In the Quick Access Toolbar, click  (Save) to save the 
project.

20. In the File tab, click  (Close). This closes the entire 
project.
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Chapter Review Questions

1. When you create a project in the Autodesk Revit software, do 
you work in 3D or 2D ?

a. You work in 2D in plan views and in 3D in non-plan views.

b. You work in 3D almost all of the time, even when you are 
using what looks like a flat view.

c. You work in 2D or 3D depending on how you toggle the 
2D/3D control.

d. You work in 2D in plan and section views and in 3D in 
isometric views.

2. What is the purpose of the Project Browser?

a. It enables you to browse through the building project, 
similar to a walk through.

b. It is the interface for managing all of the files that are 
required to create the complete architectural model of the 
building.

c. It manages multiple Autodesk Revit projects as an 
alternative to using Windows Explorer.

d. It is used to access and manage the views of the project.

3. Where do you change the Visual Style?

a. Ribbon

b. View Control Bar

c. Options Bar

d. Properties Palette

4. What is the difference between Type Properties and 
Properties? 

a. Properties stores parameters that apply to the selected 
individual element(s). Type Properties stores parameters 
that impact every element of the same type in the project.

b. Properties stores the location parameters of an element. 
Type Properties stores the size and identity parameters of 
an element.

c. Properties only stores parameters of the view. Type 
Properties stores parameters of model components.
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5. When you start a new project, how do you specify the base 
information in the new file?

a. Transfer the base information from an existing project.

b. Select the right template for the task.

c. The Autodesk Revit software automatically extracts the 
base information from imported or linked file(s).

6. What is the main difference between a view made using 

(Default 3D View) and a view made using  (Camera)?

a. Use Default 3D View for exterior views and Camera for 
interiors.

b. Default 3D View creates a static image and a Camera 
view is live and always updated.

c. Default 3D View is isometric and a Camera view is 
perspective.

d. Default 3D View is used for the overall building and a 
Camera view is used for looking in tight spaces.
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Command Summary

Button Command Location
General Tools

Home • Quick Access Toolbar

• Shortcut: <Ctrl>+<D>

Modify • Ribbon: All tabs>Select panel

• Shortcut: MD

New •

• File tab

• Shortcut: <Ctrl>+<N>

Open • Quick Access Toolbar 

• File tab

• Shortcut: <Ctrl>+<O>

Open 
Documents

• File tab

Properties • Ribbon: Modify tab>Properties panel

• Shortcut: PP

Recent 
Documents

•  File tab

Save • Quick Access Toolbar 

• File tab

• Shortcut: <Ctrl>+<S>

Synchronize 
and Modify 
Settings

• Quick Access Toolbar 

Synchronize 
Now

• Quick Access Toolbar>expand 
Synchronize and Modify Settings

Type Properties • Ribbon: Modify tab>Properties panel

• Properties palette

Viewing Tools

Camera • Quick Access Toolbar> Expand 
Default 3D View

• Ribbon: View tab>Create panel>
expand Default 3D View

Close Inactive 
Views

• Quick Access Toolbar

• Ribbon: View tab> Windows panel

Default 3D View • Quick Access Toolbar

• Ribbon: View tab>Create panel

Home • ViewCube

N/A Next Pan/Zoom • Navigation Bar

• Shortcut Menu
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N/A Previous 
Pan/Zoom

• Navigation Bar

• Shortcut Menu

• Shortcut: ZP

 
Shadows 
On/Off

• View Control Bar

Show 
Rendering 
Dialog/ Render

• View Control Bar

• Ribbon: View tab>Graphics panel

• Shortcut: RR

Switch 
Windows

• Quick Access Toolbar

• Ribbon: View tab> Windows panel

Tab Views • Ribbon: View tab> Windows panel

• Shortcut: TW

Tile Views • Ribbon: View tab> Windows panel

• Shortcut: WT

Zoom All to Fit • Navigation Bar

• Shortcut: ZA

Zoom in Region • Navigation Bar

• Shortcut Menu

• Shortcut: ZR

Zoom Out (2x) • Navigation Bar

• Shortcut Menu

• Shortcut: ZO

Zoom Sheet 
Size

• Navigation Bar

• Shortcut: ZS

Zoom to Fit • Navigation Bar

• Shortcut Menu

• Shortcut: ZF, ZE

Visual Styles

Consistent 
Colors

• View Control Bar:

Hidden Line • View Control Bar

• Shortcut: HL

Realistic • View Control Bar

Shaded • View Control Bar

• Shortcut: SD

Wireframe • View Control Bar

• Shortcut: WF
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